Work Off-Line

e Set up anew database or modify a previously saved database (without being connected to
the telephone system). This helps minimize on-site programming time.

Work On-Line (connected directly or via modem)

» Program your system viathe PC, in lieu of using the telephone programming.

» Download a database from the tel ephone system which you can modify. Then, save the data-
base to afile on your PC or upload the changes back into the phone system. Be sureto
download the entire database before saving it.

» Upload a new database to the telephone system.

Thisisthe same as using File: New from the menu bar (see page 3-3). . Connecting
D Offdine: * Opensanew (default) database. Thefirst time you use this option, you the PC
must specify aregion (U.S. or Latin America). Always select U.S.

N On-line: ¢ Not available.
ew

Thisisthe same as using File: Open from the menu bar (see page 3-4).
Off-line: « Opensan existing (previously saved) database. You cannot connect to
the system after opening a database off-line.
On-line: « QOpens an existing database and immediately uploadsinto the tele- and Start-up
phone system, overwriting the current phone system data.

. Installation

W

Open

Thisisthe same as using File: Save from the menu bar (see page 3-7).
Off-line: « Savesthe currently open database to afile on your PC hard disk. For a
new database, you will be prompted to enter a name. .
On-line: « Savesthe currently connected system’s database to afile on your PC . Programming
hard disk. You will be prompted to download the connected system’s
entire database before saving, if required.

Save

Thisisthe same as using Connection: Online from the menu bar (see
page 3-80). See page 1-2 to learn how to make adirect connection.
Offsline: « Whileon-site, directly connect to the telephone system. Thisoptionis
not available while an off-line database is open.
On-line: « Not available.

a

Direct

Thisisthe same as using Connection: Remote from the menu bar (see
page 3-81). See page 1-5 to learn how to make a modem connection.
off-line: ¢ While off-site, remotely connect to the telephone system via modem.
This option is not available while an off-line database is open.
On-line: ¢ Not available.

]
]
]

IE:

Remote

Thisis the same as using Connection: Break from the menu bar (see
page 3-83).
offline: ¢ Closeyour open file and return to the opening screen. You will be
prompted to save any unsaved data.
On-line: * Break your connection and return to the opening screen. You will be
prompted to save any unsaved data.

Break

=

Off-line: * Not avalable
On-line: *« Whileon-line, download the entire database from the tel ephone system.

£

Download
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Chapter 1: Connecting the PC

Chapter 1:
Connecting the PC

Directly Connecting the PC to the Telephone System

Overview

Directly connect your PC to the telephone system when the PC and the phone system are in the same loca-

tion. You can also use your direct connection for running the Update Utility, outputting Station Message
Detail Recording (SMDR), or recording Call History.

1 The Update Utility allows you to upgrade your system software.

1 SMDR provides arecord of the system’s outside calls. Once set up in programming, SMDR automati-
cally outputs from the system’s RS-232 (serial) port.

1 The Call History provides data on system activity. Technical Support personnel can use this datato
evaluate system performance.

Note:

1 The default communications parameters of the DS1000/DS2000 seria port are 19200 8 N 1 (19200
baud, eight data bits, no parity, and 1 stop bit).
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Chapter 1: Connecting the PC DSI000/ 2000

Directly Connecting to DS1000

To connect a PC to your DS1000 telephone system (Figure 1-1):
1.  Plug one end of amod-8 (standard 8 conductor) patch cord into the system’s RS-232 port.
2. Plug the other end of the mod-8 patch cord into the DB9 to Mod-8 Adaptor (P/N 85980).
It is recommended that you use adaptor P/N 85980. If you choose to make your own adaptor
and/or cable, however, refer to Making Data Cables on page 1-7.
3. Plug the adaptor into the DBOM COM connector on the back of your PC.
4. Usethe Direct Connection button (page 2-9) or the Connection: Online menu option (page 3-80) to
connect the PC Program to the telephone system.

Directly Connecting to DS2000

To connect a PC or laptop to your DS2000 telephone system (Figure 1-2):
1. Plug the DIN end of the 8-PIN DIN to Mod-8 Cable (P/N 80893) into the CPU seria port.
2. Plug one end of the DB9 to Mod-8 Adaptor (P/N 85980) into the cable.
It is recommended that you use cable P/N 80893 and adaptor P/N 85980. If you choose to make
your own adaptor and/or cable, however, refer to Making Data Cables on page 1-7.
3. Plug the other end of the adaptor into the DBOM COM connector on the back of your PC.
4. Usethe Direct Connection button (page 2-9) or the Connection: Online menu option (page 3-80) to
connect the PC Program to the telephone system.
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RS-232 Port
DBOM COM PORT

P/M 85980

Mod 8
Patch Cord

Figure 1-1: DS1000 Direct Connection

P/M B5880 DBSM COM PORT

CPU RS-232 Port

Figure 1-2: DS2000 Direct Connection
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Testing the Connection

To test the connection:

1.

ol

Open HyperTermina on your Windows PC or |aptop:
- Click Start + Programs + Accessories + Communications + Hypertrm.
- Double-click Hyperter m.exe.
- Name your connection, pick anicon, and click OK.
When you see the Connect To screen, open the Connect using drop down and select Direct to Com n
(where n isthe number of the PC COM port connected to the system).
Click OK after making your selection above.
When you see the COMn Properties, set the parameters to the following:
- Bits per second = 19200
- Data bits=8
- Parity = none
- Stop bits=1
- Flow control = none
Click OK after making your selections above.
Press Enter.
You may see some diagnostic data. If you press Enter again, you will see a “ greater than”
prompt (>).
If you don’ t see anything (or garbage) on your screen, check your connections and Hyper Ter-
minal settings, then restart Hyper Terminal and try again.
From the PC or laptop keyboard, press Shift 1 to enable history.
To verify the connection, lift the handset or use features at any telephone. History data will dis-
play on the PC or laptop screen.
Once you have verified that everything isworking OK, press Shift 1 again to disable history.

Checking the System’s Serial Port Settings

To check the system’s serial port settings:

1.
2.
3.
4

5.

Enter the programming mode from a display telephone.
Enter 0301 + HOLD.

PressVol mtil you see: BAUD RATE?nnnn

Enter the new baud rate, if required + HOLD.

(0=1200, 1=2400, 2=4800, 3=9600, 4=19200, and 5=38400)
Press CONF to exit program 0301.
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Connecting a Modem to the Telephone System

Overview
Use a modem connection when the phone system isin a different (remote) location than your PC. You typi-

cally use the remote connection for remote programming and troubleshooting, You would not normally use
the remote connection for the Update Utility, SMDR, and Call History.

Connecting a Modem to DS1000

To connect a modem to DS1000 (Figure 1-3):
1. Plug one end of amod-8 (standard 8 conductor) patch cord into the system’s RS-232 port.
2. Plug the other end of the mod-8 patch cord into the DB25 to Mod-8 Adaptor (P/N 85981).
It is recommended that you use adaptor P/N 85981. If you choose to make your own adaptor
and/or cable, however, refer to Making Data Cables on page 1-7.
3. Plug the other end of the adaptor into the DB25F connector on the back of your modem.
4.  Following the modem manufacturer’sinstructions, plug in the modem power supply and connect to the
trunk on which you will call to access the system remotely.
Turn to Tools: Options: Modem on page 3-79 for more on setting up the modem initialization
strings. Be sure the string includes the command to turn flow control off.
5. Usethe Remote Connection button (page 2-10) or the Connection: Remote menu option (page 3-81) to
connect the PC Program to the telephone system.

Figure 1-3: DS1000 Remote (Modem) Connection
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Chapter 2:
Installation and Start-up

Installing the PC Program

Minimum Requirements

Be sure the PC on which you want to install the PC Program meets the following minimum requirements:
1 Windows NT, Windows 2000, Windows XP, and above.

1 P133with 32 MB RAM.

1 256 Color 800 x 600 display (1240 x 1024 is optimal).

1 Do not use large fonts.

1 40 MBytes of available hard disk space.
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Installation

To install the DS1000/2000 PC Program:
Before installing, use Add/Remove Programs to remove any prior installed versions of the
DS1000/2000 PC Program.
Insert your DS1000/2000 System Administrator CD (P/N 80053-V* .** **),
Click Start + Run + Browse, then select the 80053-V*.** ** jcon.
Select the file DS-Series System Administrator Install.exe and click Open.
Click OK. After afew minutes, you see:

Ao PE

5. Click Next. You see:

{# DS-Series System Administrator - InstallShield Wizard |
Ready to Install the Program ‘
The wizard is ready to begin installation, =
& wizard is ready to begin installation

IF wou want to review or change any of your installation settings, click Back, Click Cancel to
exit the wizard,

Current Settings:

Setup Type:

Destination Folder:
C:\Program FilesiNec\DS-Series\DS-Series Syskem Administratory

User Information:
Mame:

Company:

Installshield

< Back Cancel
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6. Click Install. After afew minutes, you see:

7. Click Einish to complete the installation.
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Starting the PC Program

Initial Start-up

To start the DS1000/2000 PC Program:
1. Click Start + Programs + DS Series + DS-Series System Administrator. You see the opening

screen below.

Menu Bar

Button Bar /

Programming
Shortcuts

Program /
Area
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The PC Program Components

Menu Bar
File

[Fie | Frogramming Tools cormection neip | USE the File Menu Bar option to open a database, save a database, or
oy import portions of a stored database into your current session.
e * File: New opens anew (default) database.
— - Thisoption has the same function as the New button on the Button Bar.

e - Thisoption isnot available while on-line.

e | » File: Open opensaan existing (previously saved) database.
el - It has the same function as the Open button on the Button Bar.

L | - Thisoption is available while on-line or off-line.

- While on-line, this option |oads the saved database into the tele-
phone system. Be careful! You will of overwrite the customer
database in the connected system.

» File: Close ends your current programming session and returns you
to the opening screen.

- Thisoption is available while on-line or off-line.

- While on-line, this option breaks (tears down) your direct or
modem connection before returning you to the opening screen.

- Thisoptionis similar to the Break button on the button bar.

» File Save savesthe currently open database to the PC hard disk.

- Thisoption is available while on-line or off-line.

- For anew database while off-line, you will be prompted to enter a
name prior to saving.

- While on-line, this option always asks if you want to download the
entire system database prior to saving. Be careful! To avoid saving a
filewith incomplete data, you should download the entire database
prior to saving.

- File: Save is the same as the Save button on the Button Bar.

» File Save Asallowsyou to save the currently open database to anew
file on the PC hard disk.

- Thisoption is available while on-line or off-line.

- While on-line, this option always asksif you want to download the
entire system database prior to saving. Be careful! To avoid saving
a file with incomplete data, you should download the entire data-
base prior to saving.

» File: Import lets you import a portion of a previously saved database
into your current session.

- Thisoption is available while on-line or off-line (with anew or
saved database open).

- For example, you can import just the Toll Restriction settings from
another database into your current session.

» File: Properties allows you to enter contact information and other
data about asite. This datais saved with each file.
» File: Exit exitsthe File options.

» For more on the File options, see page 3-3.
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Programming

The Programming Menu Bar option lets you display the various pro-
grammabl e options in the program area. Each programmabl e option has
a corresponding programming shortcut to the left of the program area.
Either method accesses the same option - use the method that you find
most convenient. For more on each programmable option, refer to:
Programming: System on page 3-13.

Programming: Ports on page 3-31 and page 3-34.

Programming: Sations on page 3-37.

Programming: Trunks on page 3-46.

Programming: Extension Numbering on page 3-50.

Programming: Toll Restriction on page 3-54.

Programming: DSS Console on page 3-58.

Programming: System Speed Dial on page 3-60.

Programming: Voice Mail on page 3-62.

Tools

The Tools Menu Bar option alows you to:
» Initidize Toll Restriction.
» Usethe Online Utilities to perform various system resets, in addition
to saving and loading PC Card data (DS2000 only).
» Set up additional options, such as:
- Specifying the region preference (US or Latin America).
- Configuring the serial port for direct connections.
- Configuring the modem port for remote connections.

For more on the Tools options, refer to:

Tools: Initialize Toll Restriction on page 3-67.

Tools: Online Utilities: PC Card Load/Save on page 3-68.
Tools: Online Utilities: PC Card Load/Save on page 3-68.
Tools: Online Utilities: Reset Sation Port on page 3-73.
Tools: Online Utilities: Initialize Caller 1D Log on page 3-74.
Tools: Online Utilities: Reset System on page 3-75.

Tools: Online Utilities: Initialize System on page 3-76.
Tools: Options. General on page 3-77.

Tools: Options. Communications on page 3-78.

Tools: Options: Modem on page 3-79.

Connection

Use the Connection Menu Bar option to connect to the tel ephone system.

You can connect directly (Online), connect remotely (Remote), or Break

(tear down) an existing connection.

» Connection: Online has the same function as the Direct button on the
Button Bar. For more on Connection: Online, see page 3-80.

» Connection: Remote has the same function as the Remote button on
the Button Bar. For more on Connection: Remote, see page 3-81.

» Connection: Break has the same function as the Break button on the
Button Bar. For more on Connection: Break, see page 3-83.
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-tion |_Help

About

Search For Program Mumber, ..

The Help Menu Bar option allows you to access the Search For Program
Number utility. With this utility, just type in a telephone programming
program number (such as 1801) and the utility will automatically tell
you where the option is located in the PC Program. The Help Menu Bar
option also provides a splash screen which displays the PC Program ver-
sion number.

» For more on the Help options, see page 3-84.

DS1000/2000 PC Program User Guide
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Button Bar

New
This button is the same as using File: New from the menu bar (see page 3-3).
D | Off-line

The New button opens a new (default) database. To use this option:
» Click the button. You see:

System Selection |

" Chooze Syztem Type

psto00 | [ pszooo |
Cancel |

- Thefirst time you use this option, you must specify aregion (U.S. or Latin America).
Always select U.S.
» Select the type of telephone system you want to program. You see the opening screen for
anew (default database).

Note that the DID option is not available on DS1000.
On-line
This option is not available while on-line.
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Retrieving a Database
To retrieve a database from a telephone system and save it to your PC hard disk:

- 1. Click the Direct button to directly connect to the telephone system and enter your pass-
= I word (normally 372000).
| - You can optionally connect remotely using the Remote button.
- If the system is already in the telephone programming mode, you will see adialog
box that allows you to override the local programming.
- 2. Click the Download button to download the entire contents of the connected telephone
system’s database.
- When you see the Programs (Upload/Download) screen, be sureto click All to
download the entire database.
- The download may take 15-20 minutes.
3. Click the Save button to save your changes to a database on your PC hard disk.

- If you skip step 2 above, the program will prompt you to download the entire data-
base in this step.

Importing Data from a Saved Database

To import data from saved database and upload it into the system:

- 1. Click the Direct button to directly connect to the telephone system and enter your pass-
= I word (normally 372000).
| - You can optionally connect remotely using the Remote button.
- If the system is aready in the telephone programming mode, you will see adialog
box that allows you to override the local programming.
2. Click File: Import.
3. When you see the Programs (Upload/Download) screen, select the programs you want
to import into the system and click OK.
4.  Select the database from which you want to import the data and click OPEN.
5. Click the Send button the send the imported change to the telephone system.
6. Optionaly click the Save button to save your changes to a database on your PC hard
u disk.
7.  Click the Break button to close the file and go back to the opening screen.
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[DSI000/ 2002 Overview

Overview

Chapter3
Programming

How to use this Chapter

This chapter provides an overview of the items on the PC Program Menu Bar:

1

File

Use the File Menu Bar option to open a database, save a database, or import portions of a stored data-
base into your current session.

Programming

The Programming Menu Bar option provides access to all the PC Program programmable options. It
also explains how to use the toolbars (where available) and cross-references each screen to its corre-
sponding telephone programming option. For detailed information about each of the Programming
options, refer to the DS1000/2000 Software Manual (P/B 80000SWG16 or higher).

Tools
The Tools Menu Bar option allows you to set up direct and remote (modem) connections, save and load
data to the DS2000 PC Card, and perform various system resets.

Connection

Use the Connection Menu Bar option to connect to the telephone system. You can connect directly
(Online), connect remotely (Remote), or Break (tear down) an existing connection.

Help

The Help Menu Bar option alows you to access the Search For Program Number utility for finding
telephone programming program numbers in the PC Program. This option also provides a splash
screen which displays the PC Program version number.
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Overview

PC Programming Basics

Programming Tips

Shortcuts

r—1 Ctrl C copies datafrom a programming field.

1 Ctrl X cuts data from a programming field.

—1 Ctrl V pastes copied datainto a programming field.
—1 Ctrl Z restores the previous programming field entry.

When Connecting to a Telephone System

As soon as you connect to atelephone system (directly or remotely), the PC Program automatically down-
loads the following:

—1 All datafor station 1 (extension 300).

r—1 All datafor trunk 101.

r—1 All Toll Restriction datafor Toll Restriction Level 1.

—1 All other system data.

Additional station, trunk and Toll Restriction data is downloaded:

—1 Asrequired when you go to anew station, trunk, or Toll Restriction Level screen.
OR

— When you click the Download button.

Once connected to atelephone system (directly or remotely), you must take some action every 30 minutes or
the PC Program will break the connection.
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[DSI000/ 2000 File
New

Description

File Programming Tools Connection  Help

( [Hew. .. ,

Open...
Close

Save
Save As...

Irnpork. ..

Properties

Exit

Use the File: New option to open a new (default) database. This option has the same function as the Open
New Database button on the Button Bar. This option is only available while off line.

Programming Shortcut
—

Program Entry

To use File: New (off line only):
1. Click File: New. You see:

System Selection |

r Chooze Syztem Type

pstoo0 | [ pszooo |
Cancel |

2. Select the system database type you want to open (DS1000 or DS2000).
- The database loads into the program area.

First Time New Option
Thefirst time you select a new database, you see:
x|

Fegion Preference

s,
7 Latin America

This screen alows you select the region in which your systemisinstalled (U.S. or Latin America). For
North American applications, always select U.S.
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File [DSI000/2000
Open

Description

File Programming Tools Connection  Help
Close

Save
Save As...

Irnpork. ..
Properties

Exit

Use the File: Open option to load (open) a database previously saved to your PC hard disk. Thisoption is

available while on-line or off-line. While off-line, File: Open opens the database into the PC program. While

on-line (direct or remote), File: Open opensthefile and uploadsit into the connected system (overriding that

system’s existing database).

—1 Whileon-line, this option loads the saved database into the tel ephone system. Be careful! You have the
option of overwriting the customer database in the connected system.

Programming Shortcut
u
—

Program Entry
To use File: Open while off line:
1. Click File: Open. You see:

open 2%

Look in: |\_;ﬂ D'5-Series System Administrator j & ﬁ Ed-

File name: I"_dsx Open I
Filez of type: INEE [Drata Files [*.dsx) j Cancel |

2. Select the stored database you want to open and click Open.
- The database loads into the program area.
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File

DS1000/ 2000
Open

To use File: Open while on-line:
1. Click File: Open. You see:

DS-Series System Administrator B ﬂ

& ‘fou are about to open a new database file, Would vou like to continue?

es Mo |

2. Sincethis process will automatically upload the stored database into the connected system, click Yes.
You see:

Look in: Iaﬂ D'5-Series System Administrator j & ﬁ Ed-

File name: I"_dsx Open I
Filez of type: INEE [Drata Files [*.dsx) j Cancel |

3. Select the stored database you want to upload and click Open. You see:

4.  To continue with the upload, click Yes.
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File [DSI000/ 2000

Close

Description

File Programming Tools Connection  Help

Mew. ..

Cpen...
Save
Save As...
Irnpork. ..

Properties

Exit

Use the File: Close option to end your current programming session and return you to the opening screen.
This option is available while on-line or off-line. While on-line, this option breaks (tears down) your direct
or modem connection before returning you to the opening screen.

Programming Shortcut

-l

Program Entry

To use File: Close:
1. Click File: Close. You see:
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, File

Save

Description

File Programming Tools Connection  Help

Open...

Save

Save As...
Irnpork. ..

Properties

Use the File: Save option to save the currently open database to the same file on the PC hard disk. This
option is available while on-line or off-line. While on-line, this option always asksif you want to download
the entire system database prior to saving. Be careful! You have the option of saving a partial database —
which you can upload later over the customer database in the connected system.

Programming Shortcut

=1

Program Entry

To use File: Save:
1.
2.

Click File: Save. If you are off-line, skip to step 3.
If you are on-line, you see:

DS-Series System Administrator ll

In order ko have a complete database saved, it is necessary ko download the remaining
programs which have not been downloaded (if any), Would you like to download the
remaining programs?

Yes Mo | Cancel |

Normally, click Yesto be sure you have downloaded all the programming from the connected tel ephone
system before saving.

The database saves to the existing file on the PC hard disk.

- For anew database, you will be prompted to enter a name.
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File
Save As

Description

File Programming Tools Connection  Help

Irnpork. ..

Mew. .
Open,
Close

Save

Properties

Exit

Use the File: Save As option to save a database to afile on your PC hard disk. You can save a database you
created using the New button or a database you downloaded using the Download button. The File: Save As
option is available while off-line and on-line. While on-line, this option always asksif you want to download
the entire system database prior to saving. Be careful! You have the option of saving a partial database —
which you can upload later over the customer database in the connected system.

Programming Shortcut
N/A

Program Entry

To use File: Save As:
1.
2.

Click File: Save As. If you are off-line, skip to step 3.
If you are on-line, you see:

DS-Series System Administrator ll

In order ko have a complete database saved, it is necessary ko download the remaining
programs which have not been downloaded (if any), Would you like to download the
remaining programs?

Yes Mo | Cancel |

Normally, click Yesto be sure you have downloaded all the programming from the connected tel ephone
system before saving.

When you see:
Save As =
Save ir: Ia DS PC Program Ll gl E 5
File name: . s I—ﬁaLI
Save aslype: DS Series Dats Files [*dst) =l Cancel |
™ Open as read-only

Enter a name for your saved database and click Save.
OR
Double-click on an existing file and click Yes to overwrite a previously saved database.
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DS1000/2000 File
Import

Description

’ﬁ Programming Tools  Connection  Help
Mew. ..
Open...
Close

Save
Save As...

Properties

Exit

Usethe File: Import option to import a portion of a previously saved database into your current session. For
example, you can import just the Toll Restriction settings from another database into you current session. This
option is available while on-line or off-line. After importing the data, you can:

1 Click Send to upload the imported data to the connected telephone system.

1 UseFile: Save the save the datato the samefile on the PC hard disk (and optionally upload the changed
data to the phone system if on-line).

—1 UseFile: Save Asto save the datato anew file on the PC hard disk (and optionally upload the changed
data to the phone system if on-line).

Be careful! You have the option of saving a partial database —which you can upload later over the customer
database in the connected system.

Programming Shortcut
N/A

Program Entry

To use File: Import:
1. Click File: Import. You see:
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File [DSI000/ 2000
Import

2. Select the programs you want to import and click OK. You see:

Look in: IEQ D'5-Series System Administrator j & ﬁ Ed-

File name: I"_dsx Open I
Filez of type: INEE [Drata Files [*.dsx) j Cancel |

3. Select thefile from which you want to import the programs you selected in step 2.
4. Click OK. The selected datais imported into your existing session.
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Properties

Description

’ﬁ Programming Tools  Connection  Help
Mew. ..
Open...
Close

Save
Save As...

Irnpork. ..

Exit

Use File: Propertiesto enter important information about the remote site. You can enter contact information,
the remote telephone numbers, as well as important notes and when the site was last accessed. The proper-
tiesdatais saved as part of the database.

Program Entry

To use File: Properties:
1. Click File: Properties.
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File [DSI000/ 2000
Exit

Description

’ﬁ Programming Tools  Connection  Help
Mew. ..
Open...
Close

Save
Save As...

Irnpork. ..

Properties
Usethe File: Exit to exit the PC Program. (The system will prompt you if you try to exit while you have
unsaved changes.)

Programming Shortcut
N/A

Program Entry

To use File: Exit:
1. Click File: Exit.
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DS 1000/ 2000

Programming
System

Description

J

The Programming: System option provides access to system-wide programming.
Programming Shortcut

ke
%

System Toolbar Controls

Options

Cas |.-'l‘-.|:|:|:|unts| Grnupsl Timers |EallerID| oo |

Send | drdo |

Options

Click to access Operator and other system option programming. See System: Options
on page 3-14 for more.

(w)
o

S

Click to access Class of Service programming. See System: Class of Service (COS) on
page 3-19 for more.

Accounts

Click to access the Verified Account Codes table. See System: Account Codes
(Accounts) on page 3-24 for more.

Groups

Click to access Trunk Group programming. See System: Trunk Groups on page 3-24
for more.

Click to access the programming for system, trunk, station, and TL/E1 timers. See Sys-
tem: Timers on page 3-25 for more.

Caller ID

Click to access the Caller ID programming. See System: Caller ID on page 3-28 for
more.

D

(=]

(DS2000 Only) Click to access the DID configuration and the DID trandation table
programming. See System: Direct Inward Dialing (DID) on page 3-30 for more.

Send

* While on-line, sends the programmed changes to the connected telephone system.
* Sendisnot available while off-line.

EEEEREEENS

Undo

Cancels any changes you made to the current page.
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Programming PS000/2000
System

Options
Setup

Use this page to set up system options, operators, and other system-wide programming. Refer to the follow-
ing in the DS1000/2000 Software Manual for more:

r—1 0301 - System Options (Part 1)
—1 0302 - System I dentification

Note: For proper PC Program operation, be sure Fixed Baud Rate is enabled (checked).

More on the Modem: Installed Option

You should enable (check) Modem: Installed when an external modem is connected to the system. If
enabled, the system outputs diagnostics, SMDR and call history only while the modem is on-line.

Modem: Installed also enables the modem initialization string. The system outputs this string from the seria
port when:

This system is powered up or reset (while the modem is connected).

The string is changed in the PC Program (while the modem is connected).The system sends the init
string after the PC Program session ends.

The modem is plugged into the serial port and powered up.

Any time the Baud Rate or Modem: Installed options are changed.

Whenever you click the Break button.

000 00
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[DS1000/ 2008 Programming
System

Options

Use this page to set up additional system-wide feature options. Refer to the following in the DS1000/2000
Software Manual for more:
r—1 0201 - Tenant Option Programming

Messages

Use this page to enter the Selectable Display Messages. Refer to the following in the DS1000/2000 Software
Manual for more:

r—1 0801 - Selectable Display M essages
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[DSI000/ 2002 Programming
System

Ring Sets

Use this page to specify the Ring Tone and Cadence for each Ring Type. This program does not exist in tele-
phone programming. Refer to the following in the DS1000/2000 Software Manual for more:
—1 Digtinctive Ringing

Ring Over Page

Use the top section of this page to set up Ringing Over Page. You can separately enable Background Music,
Door Box Chimes, and station or trunk ringing over page. If you enable trunk ringing over page, use the bot-

tom portion of this page to determine which trunks will initiate trunk which type of trunk ringing. (To simul-
taneously make all entries Disabled, click Disable All.)

Refer to the following in the DS1000/2000 Software Manual for more:
r—1 0202 - Page Ring Source

r—1 0203 - UNA Ringing Over Page
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Programming [DSI000/2000
System

PBX Codes

Use this page to enter the 10 PBX Access Codes. Each code is either 1 or 2 digits long, using the digits 0-9
and * asawild card. Refer to the following in the DS1000/2000 Software Manual for more:
—1 0610 - PBX Access Codes Table
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[DS1000/ 2008 Programming
System

Distinctive Ringing

Use this page to select the Class of Service optionsthat pertain to Distinctive Ringing setup. Refer to the fol-
lowing in the DS1000/2000 Software Manual for more:
—1 0101 - Class of Service Options

Call Forwarding

Use this page to select the Class of Service optionsthat pertain to Call Forwarding. Refer to the following in
the DS1000/2000 Software Manual for more:
r—1 0101 - Class of Service Options
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Programming [DSI000/2000
System

Toll Restriction

Use this page to select the Class of Service optionsthat pertain to Toll Restriction, Walking Class of Service,
and Extension Locking. Refer to the following in the DS1000/2000 Software Manual for more:
r—1 0101 - Class of Service Options

Account Codes

Use this page to select the Class of Service optionsthat pertain to the type of Account Codesin force at asta-
tion. Refer to the following in the DS1000/2000 Software Manual for more:
r—1 0101 - Class of Service Options
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[DS1000/ 2008 Programming
System

Trunks

Use this page to select the Class of Service options that pertain to a station’s outside (trunk) calls. Note that
these are station Class of Service options, not trunk Class of Service options. Refer to the following in the
DS1000/2000 Software Manual for more:

r—1 0101 - Class of Service Options

Paging

Use this page to set the Class of Service accessto Zone and All Call Paging. Refer to the following in the
DS1000/2000 Software Manual for more:

—1 0101 - Class of Service Options
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System

Timers

System Timers

Use this page to enter values for the system timers. Refer to the following in the DS1000/2000 Software
Manual for more:
r—1 0401 - System Timers

Trunk Timers

Use this page to enter values for the analog trunk timers. Refer to the following in the DS1000/2000 Soft-
ware Manual for more:
r—1 0402 - Trunk Timers
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Programming [DSI000/2000
System

Station Timers

Use this page to enter values for the digital (keyset) station timers and the analog (SLT) station timers. Refer
to the following in the DS1000/2000 Software Manual for more:

r—1 0403 - Station Timers

r—1 0404 - Analog Station Timers

T1/E1 Timers (1 of 3)

(DS2000 Only) Usethis page to enter valuesfor the trunk timers used exclusively by the T1/E1 PCB that apply
to both T1 and E1 trunk circuits. Refer to the following in the DS1000/2000 Software Manual for more:
1 0405-TVEL1Timers
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System

T1/E1 Timers (2 of 3)

(DS2000 Only) Use this page to enter values for the trunk timers used exclusively by the TI/E1 PCB. This
page provides timers used only by T1 circuits. Refer to the following in the DS1000/2000 Software Manual
for more:

—1 0406-T1Timers

T1/E1 Timers (3 of 3)

(DS2000 Only) Use this page to enter values for the trunk timers used exclusively by the TI/E1 PCB. This
page provides timers used only by E1 circuits. Refer to the following in the DS1000/2000 Software Manual
for more:

r—1 0407 -El1Timers
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Programming
System

Caller ID

Options

SYSTEM Dpt\onsl Cas |Accounts| Groups | Timers IEallerIDl DID | Sendl Undol

Opticits I HNF’AI HMP& Exceptionsl FHPA Excapt\onsl
r—Caller ID Group Size [1307)

Group 1 I Group 3 I i]
Group2| 1] Group4| a

Group 7 I i]
Group & I a

r—Caller ID Outbound Line/Group [1302)

Calback Fouts INone i Line/Group I 1]

Use the top portion of this page to program the maximum number of records (0-99) in each Caller ID Group.
Use the bottom portion of this page to set up Caller ID outbound dialing. Refer to the following in the

DS1000/2000 Software Manual for more:
r—1 1301 - Caller ID Group Configuration
r—1 1302 - Caller ID Outbound Line/Group

1 1302 - 10 Digit Local Calls
HNPA Codes

Use this page to enter Home Area (HNPA) Codes for Caller ID Logging. The HomeArea Code istheloca area
code in which the system isinstalled. To erase all the entriesin the table, click Clear All. To sort your HNPA
entries numericaly, click Sort Data. Refer to the following in the DS1000/2000 Software Manual for more:

r—1 1303 - HomeArea (HNPA) Codes
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Programming
System

Direct Inward Dialing (DID)

(DS2000 Only) Use the top portion of this page to specify the number of incoming DID digits that should be
translated. Use the bottom of portion of this page, aswell asthe remaining DID tabs, to enter datain the DID
Trandation Table. There are 100 table entries. Each entry specifies the DID digits received, the day routing

for the call, and the night routing for the call. Refer to the following in the DS1000/2000 Software Manual
for more:

1 1401 - Number of DID Digits
r—1 1402 - DID Trandation Table
r—1 1403 - DID MFC Dialing Category
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[DSI000/2000 Programming
Ports (DS2000)
Description
| —

Use Programming: Ports (DS2000) to set up the PCB slots in the DS2000.
Programming Shortcut

Hardware Toolbar Controls

it | Auto-lD | Sﬂap’ Send| Undol

Initializes (reorders) the PCB dlots.

e Click Init to have the system reorder all theinstalled PCBs from left to right (simi-
lar toinitial power up).

» Important! If PCBs of the same type are not installed sequentially from left to
right, clicking I nit will move extensions to different PCBs. This could disrupt ser-
vicein afunctioning system.

Auto-D I

If you plug in a PCB while your PC Program session is connected, click Auto-I1D to

include the new PCB in your programming.

» Auto-1D automatically adds the new PCB, using the next consecutive group of
available port numbers.

» If youdon't click Auto-ID after adding anew PCB, it will function correctly but not
be included in the PC program until you exit and reconnect.

» To display the formation about a new PCB without including it in the PC Program
session, click Refresh instead. See Sot Status on page 3-32 for more.

Swap

Swaps the programming between two dlots.

Send

While on-line, sends the programmed changes to the connected telephone system.
e Send sends all changes made since the last Send command.
e Thisbutton is not available while off-line.

LAY

Undo

Cancels any changes you made to the current page.
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Programming
Ports (DS2000)

Slot Status

Slot Status (3900)
( Card Type |[IEDSTU

Firmware Yersion [2.4 Status Ilnslalled Refresh |

Displays the type of PCB plugged into the slot.

Shows the firmware version used by the PCB plugged into the slot.

Indicates the status of the PCB plugged into the slot.

Installed

The PCB isphysically installed and is part of the current PC Program
session.

Not installed

The PCB is physically installed but is not part of the current PC Pro-
gram session. (This occurs when you install a PCB and click Refresh
to display the dot’s data.)

Blank

The PC Program thinks the slot is empty.

Click Refresh to display the information about a PCB you have plugged in
while your PC Program session was connected to the system. Refresh
only displaysthe PCB’s information — it doesn’t include the PCB in your
open on.

The PCB will function correctly even though it is not included in your
programming session.

To automatically add the new PCB to your session, click Auto-I1D
instead. See Hardware Toolbar Controls on page 3-31 for more.

Slot 1 through Slot 8
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[DSI000/ 2002 Programming
Ports (DS2000)

Use the upper portion of this page to set up your DSTU and ASTU PCBs. Use the lower portion of this page

to set up your ATRU and other trunk PCBs. These options allow you to:

1 Set up asystem “off-ling” without any PCBs plugged in.

1 Uninstall (remove) an installed PCB. (You may want to do thisif you need to change the order of
your PCBs.)

—1 Change the Hardware Port to station assignments on an installed PCB. This lets you swap program-
ming for two devices in software without cross-connection.

—1 Swap the station assignments (and all related programming) of two installed PCBs, without cross-con-
nection.

Note that all slots except slot 1 can have both a station and trunk PCB programmed. The system “activates’
the programming for whichever PCB is plugged in. Refer to the following in the DS1000/2000 Software
Manual for more:

—1 9902 - Set Up Stations (DS2000)

—1 9903 - Set Up Trunks (DS2000)

—1 9904 - TUE1 Slot Configuration
Swapping Slots

To swap the programming between two slots:
1.  Select thetab for one of the slots you want to swap (e.g., Sot 2).
2. Click Svap. You see:

Swap Slot Data x|

Swap Slat |" with Slat IS

[T Stations [ Trueks

Cancel |

3. Inthewith Sot field, enter the number of the slot with which you want to swap all programming (e.g., 8).
4. Select the type of datayou want to swap (Sations, Trunks, or both) and click OK.
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[DSI000/2000 Programming
Ports (DS1000)

Analog Ports
ForTs _unck |

Digital Ports Analog Parts I Door onesl Trunk Portsl

— Main [3302)
Statiar Statiot Station Statior
Part 17 Port 18 [ 18 Pat19 [ 19 Pat20 [ 20
i~ Expansion [3902]
Station Station Shation Station
Fort 21 | 21 Port 22 | 22 FPoit 23 | 23 Fort 24 | 24

Use this page to set up the system’s analog ports. This page applies to analog telephones and analog voice
mail (such asVANGARD Mail and NVM-2e). By swapping the port assignments between two analog ports
(e.g., ports 17 and 18), you can swap all the related programming (and extension numbers) between the two
devices. Refer to the following in the DS1000/2000 Software Manual for more:

—1 9902 - Set Up Stations (DS1000)

I
Door Boxes
PorTs Unds |
Digital Ports | Analog Ports  Door Boxes | Trunk Ports
—Main [9902]
Statiar
Port25 | BE
r— Expansion [3302]
Station
Part 26 | 26

Use this page to set up the system’s analog Door Box ports. By swapping the port assignments between the
two door boxes (e.g., ports 25 and 26), you can swap all the related programming (and extension numbers)
between the two devices. Refer to the following in the DS1000/2000 Software Manual for more:

1 9902 - Set Up Stations (DS1000)
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Programming [DSHe0D/2000
Ports (DS1000)

Trunk Ports

Use this page to set up the system’s trunk ports. By swapping the port assignments between two trunk ports
(e.g., ports 1 and 2), you can swap all the related programming (and extension numbers) between the two
devices. Refer to the following in the DS1000/2000 Software Manual for more:

1 9903 - Set Up Trunks (DS1000)
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Programming
Stations

Options

Use this page to set up additional station feature options. Refer to the following in the DS1000/2000 Soft-

ware Manual for more:
—1 1802 - Extension Options (Part 1)
—1 1807 - Extension Options (Part 2)

Trunk Access

Stations

Use this page to set up the trunk access assignments for each station. Refer to the following in the DS1000/

2000 Software Manual for more:
—1 1803 - Extension Line Access Assignments
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Stations

Ring Assignments

Use this page to set up incoming ringing for each trunk at each station. Refer to the following in the DS1000/
2000 Software Manual for more:
—1 1805 - Ring Assignments

Programmable Function Keys

Use this page to set up a station’s Programmable Function Key assignments. If you have a 22-button tele-
phone, only the first two rows of keys are available. To assign a Programmable Function Key:
1. Pick akey type from the Key Function drop-down box.
2. Enter any additional data (such as Park Orbit or Hotline partner) in the Additional Data field.
3.  Click the key to which you want to assign the data.
- You can click additional keys to enter a sequence of assignments (such as consecutive Hotlines).
Refer to the following in the DS1000/2000 Software Manual for more:
r—1 1701 - Programmable Function Key Assignments
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DSS Keys

Use this pageto assign a station’s DSS Keys. If you have a 22-button telephone, only the first two rows of
keys are available. To assign aDSS Key:
1. Enable (check) Busy Lamp Field in the Options page.
2. Onthe DSSKeys page, enter the number of the extension you want assigned to the DSS Key.
3.  Click the key to which you want to assign the data.
- You can click additional keys to enter a sequence of DSS assignments.
Refer to the following in the DS1000/2000 Software Manual for more:
1 1703 - DSS Key Assignments
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Speed Dial (Personal) Bins 1-10

Use this page to assign a station’sfirst 10 Personal Speed Dia bins (701-710). Be sure to follow all the nor-
mal Personal Speed Dial restrictions and guidelines. To enter aFlash, type F. To enter a pause, type P. Names
can be up to 15 characterslong, using digits 0-9, upper and lower case |etters, spaces, and the following spe-
cial characters:

&

/

Refer to the following in the DS1000/2000 Software Manual for more:
1 1702 - Personal Speed Dial
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Stations

Speed Dial (Personal) Bins 11-20

Use this page to assign a station’s second 10 Personal Speed Dial bins (711-720). Be sure to follow all the
normal Personal Speed Did restrictions and guidelines. To enter a Flash, type F. To enter a pause, type P.
Names can be up to 15 characterslong, using digits 0-9, upper and lower case letters, spaces, and the follow-
ing special characters:

& ‘

/

Refer to the following in the DS1000/2000 Software Manual for more:
r—1 1702 - Personal Speed Dial
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Mailbox

Use this page to assign the station’s IntraMail mailbox options (if installed). (To set up system-wide options
for the IntraMail Voice Mail, see Programming: Voice Mail on page 3-62.) Refer to the following in the
IntraMail System Guide for more:

1 1808 - IntraMail Mailbox Options
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3. Click OK.
4.  When you see the Copy Trunk Data screen.

Select the source and destination trunk number(s).
- The source is the trunk from which you want to copy.
- Thedestination isthe trunk or range of trunks that should receive the copied data

5. Click OK.
Swaps the programming between two trunks. Note that this option does not swap trunk
Swap | numbers (see Programming: Extension Numbering instead).

1.  Click the Swap button.

2. When you see the Trunk Copy/Swap/Default Option screen, select the programs
you want to swap, or click All to swap all listed programs.

3. Click OK.

4.  When you see the Svap Trunk Data screen:

Select the source and destination ports and click OK.

A Resets the current page to its default settings.

_I 1.  Click the Default button.

2. When you see the Trunk Copy/Swap/Default Option screen, select the programs
you want to default, or click All to default all listed programs.

3. Click OK.

While on-line, sends the programmed changes to the connected telephone system.
» Send sends all changes made since the last Send command.
» Thisbutton is not available while off-line.

Send

Undo Cancels any changes you made to the current page.

LN
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Trunk Access

Use this page to set up individual trunk access. Refer to the following in the DS1000/2000 Software Manual
for more:

11006 - Outgoing I ndividual Trunk Access
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Programming

Extension Numbering

System Numbering

c— o

Use Programming: Extension Numbering to set up the system’s number plan, including station and trunk
extension numbers, UCD Hunting Groups, Ring Groups, and feature access digits.

Programming Shortcut

1.2.3...

Numbering Toolbar Controls

Click to access the system numbering options. See System Numbering on page 3-51 for
more.

Stations

Click to access the station numbering options. See Sation Numbering on page 3-52 for
more.

Trunks

Click to access the trunk numbering options. See Trunk Numbering on page 3-53 for
more.

Send

While on-line, sends the programmed changes to the connected telephone system.
* Send sends all changes made since the last Send command.
» Thisbutton is not available while off-line.

Unda

B

Cancels any changes you made to the current page.
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System Numbering

Numbering Plan

Use this page set up the system’s number plan. For each dialed digit (0-9, excluding # and *), assign a Func-
tion Type and the number of Expected Digits. Refer to the following in the DS1000/2000 Software Manual
for more:

r—1 0501 - Numbering Plan

UCD Hunting Group Numbering

Usethis pageto set up the system’s UCD Hunting Groups. For each of the 8 groups, you can assign a Master
Number, Overflow Destination, Name, and Distinctive Ringing Ring Type. Refer to the following in the
DS1000/2000 Software Manual for more:

r—1 0510 - ACD/UCD Master Extension Numbers and Names
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Toll Restriction

[DSI000/2000

Description

The Programming: Toll Restriction option provides access to the Toll Restriction programming.
Programming Shortcut

i

Toll Restriction Toolbar Controls

Level I 1

] < » | Send | Undo

i

Level [1—

Displaysthe Toll Restriction Level you are programming.

4

Go back to Toll Restriction Level 1.

Go to the previous Toll Restriction Level.

Go to the next Toll Restriction Level.

»

Jump (go to) aToll Restriction Level.

Send

While on-line, sends the programmed changes to the connected telephone system.
» Send sends all changes made since the last Send command.
» Thisbutton is not available while off-line.

[ LEEEIL

Undo

Cancels any changes you made to the current page.
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Options

Use this page to enable or disable various options for the selected Toll Restriction Level (1-7). Refer to the
following in the DS1000/2000 Software Manual for more:
—1 0601 - ConfigureToll Level Options

Equal Access

Use this page to set up the 1010 + XXX Equal Access Dialing Table. To erase al the entriesin the table,
click Clear All. To sort your table entries numerically, click Sort Data. To set up the table as an Allow
Table, click Allow. To set up the table as a Deny Table, click Deny. Refer to the following in the DS1000/
2000 Software Manual for more:

—1 0602 - 1010 + XXX Equal Access Dialing
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1+ NPA
ToLL REsSTRICTION Level [T Id| 4| »| Sendl I_Indml

Options | Equaldccess 1+ NPA | 14 Six Digh | NP&/Ne | Six Digit |

1+ NP4 Dial Cades (0603)
Table Type: (% Den}f = Allow Clear Al | Sort
it]] 13 | | a7 | 43 | 61 | 73| |
2| 14 | o | 38 | 50 | 62 | 74 | & |
2| 15 | 27| 3 | 51 | 63 | 75 | g7 |
4] 16 | 2| 40| 52 | 64 | 76 | 83|
5| 17 | 2| 4| 53 | 65 | 77| 8 |
5| 18 | an | 42 | 54 | 65 | 78 | El|
7| 139 | A | 43 55 | 67 | 73 a |
4| 20| 2| 44 56 | 6a | ao | % |
| 21| 33| 45 | 57 | 63 | a1 53|
10| 22| 3 | 46 | 5g | 70 82 | a4 |
11 23 | k| 47 | 59 | 7| a3 | % |
12| 24 | 48| 60 | 72 a4 | 56 |

Use this page to set up the 1 + NPA/NXX Dialing 3-Digit Table. To erase all the entries in the table, click
Clear All. To sort your table entries numerically, click Sort Data. To set up the table as an Allow Table,
click Allow. To set up the table as a Deny Table, click Deny. Refer to the following in the DS1000/2000
Software Manual for more:

—1 0603 - 1+ NPA/NXX Dialing 3-Digit Table

O —
1 + Six Digit
ToLL REsSTRICTION Level [T Id| 4| »| Sendl I_Indml

Options | Equal bessss| 1 +NPa, 1+ Sie Digit | NPa/N:e¢ | ik Digt |

1 + Six Digit Dial Codes [0604]
Table Type: (% Den}f = Allow ﬂl il
it]] 13 | | a7 | 43 | 61 | 73| |
2| 14 | o | 38 | 50 | 62 | 74 | & |
2| 15 | 27| 3 | 51 | 63 | 75 | g7 |
4] 16 | 2| 40| 52 | 64 | 76 | 83|
5| 17 | 2| 4| 53 | 65 | 77| 83 |
5| 18 | an | 42| 54 | 66 | 78 | a0 |
7| 139 | A | 43 55 | 67 | 73 a |
4| 20| 2| 44 56 | 6a | ao | %2 |
| 21| 33| 45 | 57 | 63 | a1 53|
10| 22| 3 | 46 | 5g | 70 82 | a4 |
11 23 | k| 47 | 59 | 7| a3 | % |
12| 24 | 48| 60 | 72 a4 | 56 |

Use this pageto set up the 1 + NPA + NXX Dialing 6-Digit Table. To erase al the entriesin the table, click
Clear All. To sort your table entries numericaly, click Sort Data. To set up the table as an Allow Table,
click Allow. To set up the table as a Deny Table, click Deny. Refer to the following in the DS1000/2000
Software Manual for more:

1 0604 -1+ NPA + NXX Dialing 6-Digit Table
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NPA/NXX
ToLL RESTRICTION Level [ 1 HI 4(r »| 5end| Undol
Options | Equal ocess | 1+ NP4 | 1+ SieDigic NPA/NX |Six Digit |
- MP&/N32% Dial Codes (0505)

Table Type: = Den_\,f " Allow Clear Al I Sorl
1] 13 | x5 | a7 | 43 | 61| 73| |
2| 14 | % | a8 | 50 | 62 | 74| |
B 15 | 27| 33 | 51 | 63 | 75 | &7 |
4| 16 | 28 | 40 | 52 | 6 | 76 | g3 |
5] 17 | | 4 53 | 65 | 77| 83 |
& 18 | 0| 4z | 54 | 66 | 74 | 0 |
7| 13 | A | 43| 55 | 67 | 73 | q |
g 20 2| 41 | 56 | 62 | a0 | 32|
g 2 x| 45 | 57 | 63 | a1 | x|
10 2z | 4 | 46 | 58 | 70| 8z | a4 |
1] 2] a5 | 47 | &} | 7| 83 | g5 |
12| 24 | a6 | 48 | &0 | 72 | a4 | 56 |

Use this page to set up the NPA/NXX Dialing 3-Digit Table. To erase all the entriesin the table, click Clear
All. To sort your table entries numerically, click Sort Data. To set up the table as an Allow Table, click
Allow. To set up thetable asa Deny Table, click Deny. Refer to the following in the DS1000/2000 Software
Manual for more:

—1 0605 - NPA/NXX Dialing 3-Digit Table

Six Digit

Use this page to set up the NPA + NXX Dialing 6-Digit Table. To erase al the entries in the table, click
Clear All. To sort your table entries numerically, click Sort Data. To set up the table as an Allow Table,
click Allow. To set up the table as a Deny Table, click Deny. Refer to the following in the DS1000/2000
Software Manual for more:

1 0606 - NPA + NXX Dialing 6-Digit Table
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DSS Console

Description

| GE—

The Programming: DSS Console option allows you to program the key assignments on the system’s DSS
Consoles. You can install up to 4 DSS Consoles (called blocks DSS1-DSS4).

Programming Shortcut

i

DSS Console Toolbar Controls

[ ss1 Dpss2 | pss3 | pss4 | Sendl Undol

]

DSS 1 Click to program the keys for DSS Console 1 (block 1).

DSS 2 Click to program the keys for DSS Console 2 (block 2).

DSS 3 Click to program the keys for DSS Console 3 (block 3).

DSS 4 Click to program the keys for DSS Console 4 (block 4).

While on-line, sends the programmed changes to the connected telephone system.
e Send sends all changes made since the last Send command.
e Thisbutton is not available while off-line.

Send

E e E

Undo Cancels any changes you made to the current page.
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Keys 1-60 and Keys 61-110
DSS CoNsoLE [Dsst pssz | pss3 | pss4 Send | Undo |

Keys 160 | Keys 51110
D55 Key Aszzignments [1704]

Function {Elge=] No Additional Data | 0

Hotline 300 [Hotline 301 (Hotline 302 (Hotline 303 (Hotline 304 (Hotline 305 [Hotline 306 |Hotline 307 |Hotline 308 (Hotline 309
1 2 3 4 5 | & | 7 | 3 | 9 10

Hotling 310 [Hotline 311 [Hotline 312 (Hotline 313 (Hotline 314 [Hotline 315 [Hotline 316 [Hotline 317 [Hotline 318 (Hotline 319
1" 12 13 14 15 | 16 | 17 | 18 | 19 20

Hotline 320 [Hotline 321 [Hotline 322 [Hotline 323 (Hotline 324 [Hotline 325 [Hotline 326 |Hotline 327 |Hotline 328 (Hotline 329
al 22 23 24 25 | 26 | 7 | 28 | 29 30

Hotling 330 [Hotline 331 [Hotline 332 (Hotline 333 (Hotline 334 [Hotline 335 [Hotline 336 Hotline 337 |Hotline 338 (Hotline 339
M 32 33 34 35 | 36 | 37 | 38 | 39 40

Hotling 340 [Hotline 341 (Hotline 342 (Hotline 343 (Hotline 344 [Hotline 345 [Hotline 346 |Hotline 347 [Hotline 348 (Hotline 349
M 42 43 “ 45 | 46 | 47 | 48 | 49 50

Hetline 350 |Hotline 351 |Hotline 352 |Hotline 353 |Hotline 354 |Hotline 355 |Hotline 356 |Hotline 357 |Hotline 358 (Hatline 359

| 81 | 82 | 53 _ | 54 __ | 56 __ | 56 | &7 __ | 58 __ |58 | 60

Use this pageto set up the selected DSS Consol€'s Programmabl e Function Key assignments. Click the Keys
1-60 tab to program keys 1-60. Click the Keys 61-110 tab to program keys 61-110. To assign aDSS Console
Programmable Function Key:
1.  Pick akey type from the Key Function drop-down box.
2. Enter any additional data (such as Park Orbit or Hotline partner) in the Additional Data field.
3.  Click the key to which you want to assign the data.

- You can click additional keys to enter a sequence of assignments (such as consecutive Hotlines).

The 24-Button DSS Console uses the first 24 keys on this page. If you prefer, you can program al 110 keys
in case you decide to upgrade to a 110-Button DSS Console later on.

Refer to the following in the DS1000/2000 Software Manual for more:
r—1 1704 - DSS Console Key Assignment
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System Speed Dial

Description

D

Use Programming: System Speed Dial to enter the system’s Speed Dial numbers and names.
Programming Shortcut

a3

LI

System Speed Dial Toolbar Controls

Bin [2000 14| < »[m] Send | Undo |

Bin | 200 Displaysthe first (lowest numbered) bin on the currently displayed page.

Go back to the first page (normally bin 200).

Go to the previous page.

Go to the next page.

Jump (go to) athe page containing a specific bin number.

While on-line, sends the programmed changes to the connected telephone system.
* Send sends all changes made since the last Send command.
» Thisbutton is not available while off-line.

Send

Undo Cancels any changes you made to the current page.

[ LEEEE
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System Speed Dial Numbers
SYSTEM SFEED DiaL  Bn[200 I<| 4 | » | »| Sendl Undol

Speed Diall

— Syztem Speed Dial Setup [1101]
Bin Type Line/Group Mumber Mame
a0 [EEwe-l [0 |
w fem =] [0 | |
2 M = [ [
03 i = [ ] |
4 [iM = |l |
w5 i = =l |
6 i = |l [
a7 i = [T | |
w8 i = [T |
9 i = [ |

Use this page to assign a station’sfirst 10 System Speed Dial bins (normally 200-209).

r—1 To assign additional System Speed Dial bins, click the Jump (go to) toolbar button and enter the bin
you want to program. The page that contains that bin will display.

Be sureto follow all the normal Personal Speed Dial restrictions and guidelines. To enter a Flash, type
F. To enter a pause, type P.

System Speed Numbers can be either 2, 3 or 4 digits long, depending on the setting of Programming:
System: Options: System Speed Dial Code Digits Setup on page 3-14.

To assign Personal Speed Dial numbers to stations, go to Speed Dial (Personal) Bins 1-10 on page 3-
43.

0 0 0

Refer to the following in the DS1000/2000 Software Manual for more:
r—1 1101 - System Speed Dial Numbers

DS1000/2000 PC Program User Guide Chapter 3: Programming [ B-61



Programming [DSI000/ 2000
Voice Mail

Description

| G—

Use Programming: Voice Mail to set up the Voice Mail and IntraMail system-wide options. (To set up
options for each IntraMail voice mailbox, see Programming: Sations: Mailbox on page 3-45.)

Programming Shortcut

)
=

IntraMail Toolbar Controls

;

System  Options | Master | Houtingl Answer | Action | Send | Undol

Click to set up options for Voice Mail ports.

Options Click to set up IntraMail System Options.

Master Click to set up the IntraMail Master Mailboxes.

Routing Click to set up the IntraMail Routing Mailbox options.

. Answer Click to set up the IntraMail Answer Tables.

Action Click the set up the IntraMail Dial Action Tables.

While on-line, sends the programmed changes to the connected telephone system.
» Send sends all changes made since the last Send command.
» Thishbutton is not available while off-line.

Send

B EEEEE

Undo Cancels any changes you made to the current page.
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Voice Mail

Voice Mail Setup

Voice Mail Setup
Voice Mail I System Dplionsl Master | Routing | Answer | Action | Send Undnl

I Trunk Access I
—Woice Mail Setup (8001]

Type IIntraMalI 'I Master Extension | 700

—%aoice Mail Options [B002)

Mame |\f'o\ce Mail # Clazs of Service |2 VI Operator I 300 Dial 9 Group ISD vl

i~ Toll Restriction Level————————————
Day ID - Might IU 'I

= Trunk Group Acci
¥ Group 90 W Group 91 I Group32 ¥ Group 93 ¥ Group 94 W Group 35 W Group 96 | Group 37 ¥ Group 98

Use this page to set up various options for Voice Mail ports. Refer to the following in the IntraMail System
Guide for more;

—1 8001 - Voice Mail Setup
—1 8002 - Voice Mail Port Options (Part 1)

Voice Mail Outgoing Trunk Access
YVoice Mall I Spstem Dpllonsl Master | Routing | Anzwer | Action | Send Undnl

Setup { Trunk Access |
i~ Trunk Line Access [B003)

Trunk  Line Access Trunk  Line Access Trunk  Line Access Trunk  Line Access
1 | Ful Access 17 | Full ocess 33 |Full Access 49 | Full Aocess
2 | Full Access 18 | Full Aocess 34 |Full Access 50| Full ccess
3 | Ful Access 19 |Full ccess 35 |Full Access 51 |Full decess
4 |Full fccess 20 |Full ccess 36 |Full dccess 52 |Full bccess
5 |Full Access 21 |Full docess 37 |Full Access 53 |Full bocess
& | Ful Access 22 | Full Aocess 38 |Full Access 54 | Full ccess
7 | Full Access 23 |Full ccess 23 |Full Access 55 | Full Access
B8 | Ful Access 24 |Full Access 40 |Full Access 56 | Full Access
9 | Ful Access 25 |Full Aocess 41 |Full decess 57 |Full becess

58 | Full Aocess
59 | Full Access
B0 | Full Access
Bl |Full bocess
B2 |Full docess
B3 |Full docess
B4 |Full docess

42 |Full Access
43 |Full Access
44 |Full Access
45 |Full Access
46 |Full Access
47 |Full docess
43 |Full Access

2B |Full Aocess
27 |Full Aocess
28 |Full dccess
29 |Full ccess
30 | Full Aocess
31 |Full Access
32 |Full docess

10 |Full Access

11 |Full Access
12 |Full Access
13 |Full Access
14 |Full Access
15 |Full &ccess
16 |Full Access

RN R T R R )

R R K

RN R R R R R R )

R R R T R

Use this page to set up outgoing trunk group access for Voice Mail ports. Refer to the following in the Intra-
Mail System Guide for more;
1 8003 - Voice Mail Port Options (Part 2)
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Voice Mail

IntraMail System Options

YVoice Mall Systemn I Dptinnsl Master | Routing | Angwer | Action |

Send | Undo |

Options I

— IntraM ail Options [B004)
Subscriber Meszage Length I Sec. [1-4095)
Mon-Subscriber Meszage Length I 120 Sec. [1-4095)

Meszage Backup/ddwance Time I 5 Sec [1-60)

Fax Transter Extersion

IUND

i~ Notification Option:
Motification Attempts I 5 Attempts [1-99)
Rings for R4 Notification I 5 Rings [1-39)

Natification Interval
Busy Motification Call Interval

R Notification Call Interval

[ 20 Min. 1-255)
[T15 i 1-2585)
|30 Min. (1-255)

r— Pager Notification Option:

Pager Callback Mumber IX*M#

[ Fiety Pager Notify Until Acknowledged

Pager Notifization Interval

Pager Callback Dial Delay

[ 15 Min. (1-255)
[ 5 secingg)

Use this page to set various IntraMail System Options. Refer to the following in the IntraMail System Guide

for more:
1 8004 - IntraMail System Options

IntraMail Master Mailbox Options

Use this page to set up the 16 IntraMail Master Mailboxes. Refer to the following in the IntraMail System

Guide for more:

1 8005 - IntraMail Master Mailboxes
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Voice Mail

IntraMail Dial Action Tables

Use this page to set up the 16 IntraMail Dial Action Tables. Refer to the following in the IntraMail System
Guide for more:
r—1 8008 - IntraMail Dial Action Tables
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Tools

Online Utilities: PC Card Load/Save

Description

Tools  Connection  Help
Initislize Toll Restriction. .. I
Onling LUtilities PC Card LoadiSave. ..

Reset Station Paort...
Initialize CID Log
Resel System
Initialize System

Options. ..

In DS2000, PC Card Load/Save allows you to back the site datato a Data Base PC Card (P/N 85880),
restore site data from the PC Card, and completely erase the data stored on the PC Card. PC Card Load/Save
combines the functions of the following DS2000 telephone system programs:

—1 9906 - Database Save

—1 9907 - Database L oad

—1 9908 - PC Card Erase Utility

To save a DS2000 database to a PC Card (P/N 85880):

1

2.

4,

Following the instructions in your system’s Hardware Manual, insert Data Base PC Card P/N 85880
into the CPU.
Click Tools: Online Utilities: PC Card Load/Save. You see:

D5-Series System Administrator N 5]

Be sure to send any changes you have made to the system, otherwise they will not be
saved to the flash card!!!

Since PC Card Load/Save backs up whatever datais in the DS2000 CPU, be sure you have uploaded
all the required data and click OK. You see Save/Load Main Screen:

In the Location field, enter the address of the database (00-15) to which you want to save the data.
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[DSI000/2004 Tools
Online Utilities: PC Card Load/Save

5. Click Save. You see:
Communications setup |

Fleaze enter the name of the databaze you wizh to save.

D atabase Mame: |

Cancel |

6. Enter aname for the database you wish to save (up to 15 characters) and click OK. You see:

7.  Enter the system password (normally 372000) and click OK. You see:
x

& Start of Data Save is Successful, This may take several minutes to complete, Please
‘W aik!

8. Click OK to begin the database save. After afew minutes, the save completes and you see:

9. Click OK to return to the Save/Load Main Screen.
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Online Utilities: PC Card Load/Save

To format (erase) a DS2000 database PC Card (P/N 85880):

Formatting the PC Card will erase all data stored on the card.

1. Following theinstructionsin your system’s Hardware Manual, insert Data Base PC Card P/N 85880

into the CPU.
2. Click Tools: Online Utilities; PC Card Load/Save. You see:
|

Be sure to send any changes you have made to the system, otherwise they will not be
saved to the flash card!!!

3. Click OK.You see Save/Load Main Screen:

4., Click Reformat Flash. You see:

5. Enter the system password (normally 372000) and click OK. You see:

DS-Series System Administrator N ll
& Start of Re-Format is Successful, Please wait, this will only take a moment.
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Online Utilities: PC Card Load/Save

6. Click OK to reformat the PC Card. When the reformat completes, you see:

DS-Series System Administra x|
& Card Format Completed Successfully

7. Click OK to return to the Save/Load Main Screen.
- You must reconnect to the system to continue programming.
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DSI000/ 2000 Tools
Online Utilities: Reset Station Port

Description

Tools  Connection  Help
Initialize Toll Restriction. .. I |
Onling LUtilities PC Card Load/Save. ..
Initialize CID Log
Resel System
Initialize System

Options. ..

Reset Sation Port allows you to reset an extension. Thisis the same as using tel ephone system program
9901 - Reset Station Port.

To reset an extension:
1. Click Tools: Online Utilities: Reset Sation Port. You see:

x
Extension: I3DD

2. Enter the number of the extension you want to reset (e.g., 300) and click OK. You see:

3. Click Yes. The extension resets and you see:

4. Click OK.
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Tools DS
Online Utilities: Initialize Caller ID Log

/m

S

&
S |

S
S

Description

Tools Connection  Help
Initialize Toll Restriction. .. I |

Cnline Lkilities PC Card Load|Save. ..
Reset Station Paort...

Cptions...
plions Initialize CID Log

Resel System
Initialize System

Initialize CID LOG toinitiaize (clear) all the Caller ID logs system-wide. This clearsall the personal logs as
well as all the group logs. It has no effect on other Caller ID programming. Thisis the same asusing tele-
phone system program 9804 - I nitialize Caller ID Log Utility.

To reset the Caller ID logs:

1. Click Tools: Online Utilities: Initialize CID Log. You see:

2. Click Yestoinitialize the Caller ID logs. You see:

3. Click OK.
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Online Utilities: Reset System

Description

Tools Connection  Help
Initialize Toll Restriction. .. I |

Cnline Lkilities PC Card Load|Save. ..
Reset Station Paort...
Initialize CID Log

Initialize Syskem
Use Reset System to do areboot (warm reset) of the system without initializing. Thisis the same as pressing
your system’s red reset button.

To reset system:
1. Click Tools: Online Utilities: Reset System. You see:

Options. ..

2. Click Yesto reset the system. You see:

51
& Reset Successful, Please re-establish connection with the system
3. Click OK.

- You must reconnect with the system to continue programming.
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Tools DSt000/2000
Online Utilities: Initialize System

Description

Tools  Connection  Help
Initialize Toll Restriction. .. I |
Cnline Lkilities PC Card Load|Save. ..
Reset Station Paort...
Initialize CID Log
Resel System

Initialize System

Use Initialize Systemto initiaize the system database. | nitializing the system database erases all your pro-
grammed entries and replaces them with the factory-installed default values. do areboot (warm reset) of the
system without initializing. Thisis the same as using system program 9804 - I nitialize Caller ID Log Utility.
To initialize the system:

1. Click Tools: Online Utilities: Initialize System. You see:

Options. ..

2. Click Yestoinitialize the system. You see;

51
& Reset Successful, Please re-establish connection with the system
3. Click OK.

- You must reconnect with the system to continue programming.
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[DS1000/2000 Tools
Options: General

Description

c—

Use Options: General to set the Region Preference for new databases you create using the PC Program. In
North America, always choose United States as the Region Preference. Selecting Latin America will:
Enable the Latin American Toll Restriction optionsin Programming: Toll Restriction.
Enable A-Law Companding in Programming: System: Setup: Companding.
Enable Spanish as the SMDR language in Programming: System: Setup: SVIDR.
Enable Spanish as the telephone display language in Programming: Stations: Options: Display.
Change the Time and Date format in Programming: System: Setup: Time/Date to (for example)
10 MAR TUE 15:15 (from the US standard of 3-10 TUE 3:15 PM).
To set the Region Preference:
1. Click Tools: Options and click the General tab. You see:

|

General | Eommunicationsl Modeml

00000

— Fegion Preference

0k I Cancel |
2.  Make sure United Satesis selected and click OK.
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Tools

Options: Communications

Description

c—

Use Options: Communications to set the RS-232-C serial port parameters of the PC running the DS 1000/2000
PC Program.When connected directly to the telephone system, the PC will use these settings. Do not change
these settings once connected. Initialy, the settings are:
r—1 Com 1 Selected
—1 38,400 Baud

1 No parity
—1 8databits
1 1 stop bit

The PC communicates with the telephone system using the settings you enter in this option. When the pro-
gramming session ends (i.e., you break the connection), the tel ephone system returns to the settings specified
in 0303 - CPU Baud Rate.

Note: The default baud rate for the telephone system is 19200 baud, with the Fixed Baud Rate option
enabled. See Programming: System: Options on page 3-14 for more.

To set PC serial port parameters:
1. Click Tools: Options and click the Communications tab. You see:

Application Dptions 1

General  Communications | Modeml

—COM Part

 COM1 ¢ COM2 ¢ COM3 C COM4  COMS ¢ COMEB

—Baud Rate

300
33400

1200

2400

4800 ¢ 9600 7 19200

— Data Bit

[l G

{

Stop Bit:
o »

Paiity
’7 & Mone © Ewen 7 Odd

(u]8 I Cancel |

x|

2. Makeyour selections as required and click OK.
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[DSH000/2000 Tools
Options: Modem

Description

c—

Use Options: Modem to set the PC modem’s initialization string and whether the modem uses tone (DTMF)
or pulse (DP) dialing. Options: Modem also sets how long the PC Program will wait for Timeout (i.e., for the
remote modem to answer and connect).
—1 Theinitiadization string for your PC modem should be: ATT E0 Q0 M1 V1.
1 Theinitialization string for the modem connected to the remote system should be:
AT Q1 &C1 &DO0 &S1 S0=1 E0 &W0 &W1
Be sure this string includes the command to turn flow control off.
r—1 For more on the modem settings, see Connection: Remote on page 3-81.

To set the modem options:
1. Click Tools: Options and click the Modem tab. You see:
|

Generall Commurications  Modem |

i~ Initizlize Maodem

|nitialize: l

Init String |y 0RI0ERRRS

—Dial Type
@ Tore  Puke TimeoutIBD 'l

ak. I Cancel |
2. Makeyour selections as required and click OK.
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Connection [DSI000/2000
Online

Description

| a—

Use this option to connect directly from your PC’s seria port to the telephone system.
To make a direct connection to the telephone system:
1.  Turnto Chapter 1: Connecting the PC to review the cabling requirements.
2. Click Connections: Online.
- You can aso click the Direct Connection button on the button bar.
3. Whenyou see:

Enter the system password (hormally 372000) and click OK.

- The PC communicates with the telephone system using the settings you enter in Utilities: Initialize
Toll Restriction on page 3-67. When the PC programming session ends (i.e., you break the connec-
tion), the telephone system returns to the settings specified in 0303 - CPU Baud Rate.

Note: If reconnecting after an unexpected disconnect, you may see a* communication synchronization”
error message. Just select this option to try again.
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DSI00T/ 2000 Connection
Remote

Description

| G—

Use this option to connect to the telephone system remotely via modem.
To connect to the telephone system remotely via modem:

1. Turnto Chapter 1: Connecting the PC to review the modem and cabling requirements.

2. Click Connection: Remote.
- You can also click the Remote Connection button on the button bar.

3. Yousee

Mumber ta Dial I

Call Statuz INot Connected

Settings | InitModeml Dial | Cancel |

4. To verify that your modem port settings are compatible with you modem, click Settings. You see:

— COM Part

& COM1 ¢ COM2 ¢ COM3 ¢ COM4 ¢ COMS ¢ COME

—Baud Rate
300 1200 € 2400 € 4800 €7 9600 & 19200
33400

— Data Bit: Stop Bit: Parity
17 v 3 ’76’1("2 {GNonerEvended

()8 | Cancel |

- Select the Com port, baud rate, parity, data bits, and stop bits as required.
- Click OK when you are done.
- Do not change these settings once connected.

5. To verify your PC modem’s initiaization string, click Init Modem. You see:

Application Dptions b 1'

Generall Communications  Madem |

Initialize Modem

Init String  [EYN=ER{NR RS |ritislize l

Dial Type
@ Tone ( Pulse TimeoutIBD 'I

oK I Cancel |

- Theinitiadization string for your PC modem should be: AT E0 Q0 M1 V1

- Theinitialization string for the modem connected to the remote system should be;
AT Q1 &C1 &DO0 &S1 S0=1 E0 &W0 &W1

- Click OK when you are done.

- Set Timeout interval. The remote modem must respond within this interval.
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D00/ 2007

Connection WS
Remote

S

6. Inthe Number to Dial field, enter the phone number of the remote system.
- The number should contain any required access digits.
- Toenter apause (for example, after atrunk access code), enter a comma (,).

7. Click Dial.
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DSI000/2000 Connection
Break

Description

| G—

This option ends your current programming session and returns you to the opening screen. It is available
while on-line or off-line. While on-line, this option breaks (tears down) your direct or modem connection
before returning you to the opening screen. This option is the same as File: Close and the Break Connection
button on the button bar.

To break the connection with the telephone system and return to the opening screen:
1.  Click Connection: Break.

- You can aso click the Break Connection button on the button bar.
2. Yousee
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Help DS I000/2000

Search For Program Number

Description

If you know atelephone programming program number, use this option to help you locate it in the PC Program.

To find a program number in the PC Program:
1. Click Help: Search For Program Number. You see:

Program Search
Frogram Mumber |E
oK I Cancel |

2. Enter the number of the program you want to locate and click OK.
- A dialog box will explain where the program is located.
- For example, if you entered 1801 and clicked OK, you would see:

Ds-Series System Administrator j 1]

This program is located under the EXTENSION icon {or menu item under the Programming
menu category) in the Fourth tab labeled Ring Assign,
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DS 1000/ 2000 Help
About

Description

G

Use this option to display the PC Program version number.
To display the PC Program Version Number:
1. Click Help: About. You see:

About D5-5eries Spstem Administrator
D5-5eries System Administrator
T

Wersion
Copyright [C] 2003 MEC America
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Help DSI000/ 2000
About
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NEC

NEC America, Inc., Corporate Networks Group
4 Forest Parkway, Shelton, CT 06484
Tel: 800-365-1928 Fax: 203-926-5458
cng.nec.com

Other Important Telephone Numbers

Sales: . ... e 203-926-5450
Customer Service: . ... 203-926-5444
Customer Service FAX: ... ... .. . . 203-926-5454
Technical Service: . .......... .. . .. . . .. . . ... 203-925-8801
Discontinued Product Service: .................. 900-990-2541
Technical Training: . . ......... ... .. ... ........ 203-926-5430
Emergency Technical Service (After Hours) ........ 203-929-7920

(Excludes discontinued products)



*80053INS02*
80053INS02

NEC

NEC America, Inc., Corporate Networks Group
4 Forest Parkway, Shelton, CT 06484
TEL: 203-926-5400 FAX: 203-929-0535
cng.nec.com

December 5, 2003
Printed in U.S.A.
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